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Period Sales Analysis by Branch 

DashSalesAnalysisPeriodByBranch.CLR 

 

Description  

Same as Daily Sales Analysis by Branch (see page 121), but instead of only showing a day's worth of 
transactions it shows the entire period's transactions and orders to date. Also notice the period progress 
bar at the top. All other features are the same. 

Period Sales Analysis by Primary Stock Group 

DashSalesAnalysisPeriodByPriStkGrp.CLR 

Description  

Same as Period Sales Analysis by Branch (see page 122) but shows drilled graphs by Primary Stock Group 
instead of branch. 

Period Sales Analysis by Secondary Stock Group 

DashSalesAnalysisPeriodBySecStkGrp.CLR 

Description  

Same as Period Sales Analysis by Primary Stock Group (see page 122) but shows drilled graphs by Secondary 
Stock Group instead of branch. 

Period Sales Analysis by Salesperson 

DashSalesAnalysisPeriodBySalesperson.CLR  

Description  

Same as Daily Sales Analysis by Branch (see page 121) but shows drilled graphs by Salesperson instead of 
branch. 
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Top Customers by Margin 

DashTopCustByMargin.CLR 

 

Description  

This Dashboard view (a "top" view) shows the top customers by the total amount of margin on products 
they purchased. This gives an idea of the most profitable customers, which may not be the same as the 
customers who buy the most or buy the most often.  

Features  

All "top" views allow you to show the top 10, 20 or 50 records fitting the criteria. You can then view the 
statistics for the last week, month, year or overall. All views also allow you to view as a list or a chart (blue 
icon at the top right of the left view above).  

Click on a bar on the chart or an item in the list to "drill" to the history of the customer over the previous 13 
periods, showing both sales value and percent margin. 13 periods allows you to compare the current 
figures with the same period last year (if you are based on 12 periods per financial year). This view shows 
the distribution of the sales over the periods.  

Note: The Week/Month/Year/All filters have no effect on this chart, and are therefore hidden.  

Click on the chart to go back or click on the title (customer name) to open the MYOB EXO Business Debtor 
Account window on the selected account.  
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Top Customers by Revenue 

DashTopCustByRevenue.CLR 

Description  

Same as Top Customers by Margin (see page 123) but chart shows sales figures instead of margin. 

Top Stock by Margin 

DashTopStockByMargin.CLR 

 

Description  

Same as Top Customers by Revenue (see page 124) above but shows the details for stock items.  
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Top Supplier by Spend 

DashTopSuppliersBySpend.CLR 

 

Description  

Same as Top Customers by Margin (see page 123) but for suppliers, based on the total purchases made 
through each supplier in the given period. Only the total purchase amount is shown.  

Job Costing Dashboards 

Dashboard List 
A range of Dashboard views specific to the MYOB EXO Business Job Costing module are available. 

Dashboard Name File Name 

Jobs Nearing Completion (see page 126) DashTopJobsNearingCompletion.CLR 

Due/Overdue Jobs (see page 127) DashDueOverdueJobs.CLR 

Job Alerts (see page 128) DashJobAlerts.CLR 

Job Status (see page 129) DashJobStatus.CLR 

Top X Jobs by Margin (see page 130) DashTopJobsByMargin.CLR 

Top X Jobs by Revenue (see page 131) DashTopJobsByRevenue.CLR 

Serviceable Units Due for Service (see page 132) DashServiceableUnitsDue.CLR 
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Jobs Nearing Completion 

DashTopJobsNearingCompletion.CLR 

 

Description  

This report will show a list of the top 10, 20 or 50 jobs ordered by Due Date with the most recent first. 
 Clicking on the job will open the EXO Job Costing detail screen on the selected record.  

Features  

The report has two parameters: 

 Show top (to select the default "top" count, 10, 20, or 50) 

 Jobs due within how many days. 

The data is filtered to show only those jobs with a Due Date that falls between today's date and (today's 
date + days parameter) inclusive. 
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Due/Overdue Jobs 

DashDueOverdueJobs.CLR 

 

Description  

This Dashboard shows a "pipeline" view of jobs where the jobs fall into one of three categories: overdue, 
due today, or due within a specified number of days.  The number of jobs is shown in the graphical 
representation as well as a list view. Either the pipeline or the list items can be clicked on to drill down and 
see the jobs in that category. Clicking again on the drilled list item takes the user to the EXO Business Job 
Costing detail screen.  

Features  

Provides one parameter: "Show jobs due within how many days". This parameter allows the effective 
length of the pipeline to be changed. 

Note: Overdue jobs and jobs with a due date today will always be shown in the pipeline. 

The pipeline will be shown at the top of the screen in the main view as well as the drill-down view. 
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Job Alerts 

DashJobAlerts.CLR 

 

Description  

This Dashboard is a simple indicator view of job alerts. It lists all incomplete and unarchived jobs that have 
one of four system alerts against them: Quote Expired, Quote Price Exceeded, Over Budget, and Overdue. 
From this view you can drill directly to the EXO Business Job Costing detail or to the Debtor Account detail 
screens for each job.  

Features  

There are no parameters for this report, all active jobs with alerts will be shown. Clear indicators show jobs 
that need attention at a glance. 
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Job Status 

DashJobStatus.CLR 

 

Description  

This report lists all the job statuses that have been set up for Job Costing with a count of the number of jobs 
that are assigned to that category within the date and job ranges that are specified. Clicking on the status 
will drill down to the list of jobs that make up that status, and clicking on the job code or account will open 
the EXO Business Job Costing or Debtor details screens respectively.  

Features  

There are four parameters: From Job, To Job, Job Status and a due date range. From/To Job allows you to 
specify a range of job numbers to monitor. Job Status allows you to specify which job statuses are shown in 
the list. The due date range has the following options: 

• Today - only shows jobs that are due today (any time). 
• This week - shows all jobs due any time in the current week (Sun-Sat). 
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• Within a 2 week window - shows all jobs that fall in a sliding 2-week window.  This is defined as the 
7 full days leading up to and including today, followed by the next 7 full days.  For example, if today 
is the 20th the due date range will be from the 14th through to the 27th inclusive (14 days). 

• This month - shows all jobs due any time in the current month. 

Within a 2 month window - shows all jobs that fall in a sliding 2-month window. This is defined as one 
month prior to tomorrow's date through to one month after today's date inclusive. For example, if today is 
16 December the due date range will be from the 17 November through to 16 January of the following year 
inclusive (the two full months being 17/11 - 16/12 and 17/12 - 16/01). 

Top X Jobs by Margin 

DashTopJobsByMargin.CLR 

 

Description  

This Dashboard lists the top 10, 20 or 50 jobs by the margin of the invoiced portion of the job, either in a 
chart view or a list vie.  
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Features  

There is only a single parameter for this report, which determines whether the user sees 10, 20 or 50 items 
by default. The chart is sorted by margin which is calculated in descending order based on the invoiced 
amounts against each job. For this reason it will only show jobs that have something invoiced against them. 
The only other filtering that is applied is to remove any jobs with a status that has the "Archived" flag set. 
This view is not intended to necessarily provide a view of current jobs, just any jobs that are not archived. 

Top X Jobs by Revenue 

DashTopJobsByRevenue.CLR 

 

Description  

This report is identical to the Top Jobs by Margin (see page 130) Dashboard report, except that it shows the 
jobs sorted in descending order by overall (invoiced) revenue.  

Features  

The same features apply to this report as the Top Jobs by Margin (see page 130) Dashboard report. 
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Serviceable Units Due for Service 

DashServiceableUnitsDue.CLR 

 

Description  

This Dashboard lists all of the servicing that is overdue, due today or due within a certain specified period. 
Overdue servicing is indicated by a red due date. By clicking on the line you can drill down to see details on 
the serviceable unit, the SU Contact and the associated company (Debtor, Creditor or Non Account) as well 
as the last 200 characters of notes against the account. By clicking Show S.U. you can be taken directly to 
the Serviceable Units detail screen for more information. You can also click on the Show Account link 
(different for Debtors, Creditors and Non Accounts) to be taken to the account details screen.  
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Features  

There are two parameters for this report: 

• Include services due within how many days - allows you to specify how far into the future you want 
to see scheduled serviceable units.  SU's will always show when due today or overdue. 

• Exclude overdue servicing - allows you to exclude overdue service jobs. 

Dashboard Design 

What Constitutes a Good Dashboard View?  

It is important that when designing a Dashboard you consider usability as your primary concern. By 
following a few simple design concepts, you can make Dashboards that are effective, functional and have a 
great look. Creating Dashboard designs is becoming an art – and already many books are dedicated to it. 

It seems that everyone wants a Dashboard of some kind on their product – new applications come out 
every day sporting a new look Dashboard, from your search engine home page to your antivirus program.  

Just having a Dashboard won't make you more productive for using it. However, it should: 

• provide you more relevant information than before 
• in a more easily accessible place 
• in a clear uncluttered way that allows you to act on it.  

Consider the points below in your Dashboard design. 

Be Clear about What you are Showing 
Make sure that you know exactly what it is you are trying to display, and consider the best (cleanest, 
clearest, most effective) way that this might be captured. Descriptive titles are also helpful, it should be 
immediately apparent to anyone viewing the dashboard for the first time as to the exact purpose of it.  

Be sure that you know what the figures truly represent (this, of course goes for all report writing):  

• If they are sales figures, are they tax inclusive or exclusive?  
• Local or foreign currencies? 
• If the report is supposed to show staff sales performance, does it take into account the number of 

hours worked?  

None of the answers to these questions are necessarily wrong, but make sure that the answers to these 
kinds of questions are clear both to you and to the dashboard users.  

Note: Don't try to show too much information in one place, but be aware that a dashboard can still 
show a rich collection of useful data clearly, if it is well designed. Keep the display clear and to the 
point. Make sure that units are shown where necessary.  

Be Clear about the Target Audience 
You must also consider who the likely audience is going to be, ask yourself these questions to get a clearer 
picture: 

• What will they expect to get out of it?  
• Is it really going to make their job easier? 
• Or is it just going to be more information to deal with?  
• What will they use this information for?  
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Avoid Glitz at the Expense of Usability or Readability 
Many dashboards actually try to look like real "dashboards" - dials and bezels, speedometers and 
thermometers, lights, colours and all manner of glitz.  

Unfortunately, it's all distracting from the real message, and often these displays convey very little useful 
information at all.  

Smart and Prudent use of Colour 
Use colours carefully – colours should be used to make information stand out, and if everything is coloured 
then the important information gets lost. Good designers will also remind you that around 10% of men and 
1% of women are red-green colour-blind, so red and green indicators (e.g. for good/bad performance) may 
not be such a good idea from a usability perspective.  

Try to choose softer colours for your dashboard designs, and only use bold colours where something really 
needs to stick out. Black, white and greys are good base colours to begin with, and then one or two colours 
can be used for highlighting.  

Logical Grouping of Information 
Keep like information together. This goes for view design and placement on the Dashboard. Ensure that as 
a user reads down the page (usually from top left to bottom right, more or less), the information has a 
logical order and grouping.  

Focus on the Most Useful Data 
The most useful data on a Dashboard is the current data. Don't emphasise historical data, or even future 
trends: they are only really needed for comparison. Keep the focus on current data, current trends, current 
items requiring attention, current performance. 

Choose the Chart for the Job 
While charts are useful for displaying information, it can be difficult to make sense of the data if you choose 
the wrong type of chart. Consider what people want to get out of the chart, and comparisons that might 
need to be made between elements of the chart.  

For example, which chart below makes it easiest to determine relative sales performance of each staff 
member? Why?  

  

Humans are not very good at comparing angles, but can easily determine length and height. For this 
reason, pie charts are somewhat limited in their effectiveness when compared with other types of charts 
for many purposes. What makes matters worse is that the above pie chart is tilted, distorting the angles.  
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Common Features 

The standard MYOB EXO Business dashboard views outlined in the previous chapter share many things in 
common in order to create a unified look and feel across the dashboard, but you are not limited in what 
you can do with your views. Note that most of the features are implemented using tools that were already 
in Clarity and are not new to version 7. Complete details of their implementations are included in this 
document at this time, but hopefully enough clues are provided so that these and many other new features 
can be implemented by creative dashboard designers.  

 
Here are the features common to some of these views:  

Radio Buttons  
These are used in the range selection for the "top" reports, to show for example, Top 10 Suppliers by 
Spend. While radio buttons are used extensively in Windows forms and web pages, Clarity does not have a 
radio button tool, so these were created with circles, text and click events. When an option is selected, the 
circle fill colours are changed, the selected option's text is shown in bold, the relevant filter options are 
changed, and the report is refreshed. 

 

Tabs  
These give the appearance of a tabbed sheet where clicking a tab brings that sheet to the front. This 
feature is created simply using rounded rectangles with some text placed on top. The rectangles have an 
OnDrawCommandClick event handler which changes the colour of the rectangles, sets the new filter value 
and refreshes the report. The colours are designed to merge into the gradient panel below when selected 
(see below): 

 

Text/Chart button  
This allows the user to change between different views of the same data. Some people prefer to look at 
visual charts, others like to see data in a list view. All this button does is toggle a global variable which 
stores the current state, then hides what shouldn't display and shows what should. 
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Progress meter 
This could probably have been implemented with a TeeChart, but it seemed overkill for just showing the 
progress through the current period. This feature was implemented as a few rectangles and a text label. The 
length of the bar is determined as a percentage of the total length of the meter, based on the length of the 
period and the current day of that period.  

 

Charts 
The chart component (called a TeeChart) is fully functional in EXO Business version 7. It is a powerful 
charting engine that allows you to customise charts almost endlessly. Many dashboard views use more 
than one chart, and most of them use more than one "series" of data in each chart, showing and hiding the 
series as required. 

Note: You will notice that the dashboard views all have a background shading effect, going from a 
light grey at the top to a medium-light grey at the bottom. This is built into the dashboard not into 
the report itself, and cannot at this stage be turned off or changed in colour.  

TeeChart 

Reports > Clarity Report Designer 

TeeChart is simply the name of the 3rd Party component that is used in MYOB EXO Business to give 
extensive charting capabilities. A TeeChart is added to your report in the same way as any other object, by 
selecting the icon in the toolbar.  

Note: There are two buttons you can use with slightly different properties, just as there are for many 
other tool types. 

 
The first TeeChart button is the regular Chart tool. The second button is the DBChart tool, or the data-
bound chart tool. The DBChart tool is identical to the Chart tool in functionality and features except that it 
can take fields in a data pipeline as a source for the data on the chart.  

Both kinds of chart can show static data, either hard-coded when the report is designed (not very useful), 
or added by code at runtime, from any source (data pipeline, parameters, calculations or otherwise).  
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Creating a new chart  
Select the Chart tool and add a chart to a new report canvas. When you create a chart, it won't have any 
data in it:  

  

Right click on the chart and select "Edit Chart":  
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At this stage, don't be too daunted by the number of options, we're just going to look at some of the Series 
options. Ensure that "Series" is selected on the left and click Add on the right: 

 
Select the chart type from the list and Click OK:  
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You've just added a data series to your chart. You can add as many series as you like. A series is similar to a 
data series in Microsoft Excel or other programs, and allows you to show data from different sources 
overlaid on top of each other. While each series can potentially be a different type of chart, this is rarely 
useful. One use, however, is to superimpose a line chart and a bar chart.  

Now that you have added a series, you can add some data to it. Select the new series (it should be called 
"Series1" or similar) from under "Series" on the property tree on the left, then select the Data Source tab:  

  

Under Data Source you have the option of several sources of data. These are as follows:  

Manual  
This allows you to enter your own data in the grid below. Simply click the cell and type the data you want, 
and press the Insert key on your keyboard to insert a new data row.  

Random  
For demonstration purposes, you can quickly add a number of randomly assigned data points. Select the 
Random option, choose the number of data points you want, then click the Apply button. You can either 
close the window to see the new chart or select "Manual" from the dropdown list again to see the list of 
values that were generated for you.  

Series & Function  
These are not currently used.  

Data Pipeline (only available with a DBChart component)  

This allows you to specify which properties of the chart take their data from fields in a data pipeline. This 
will be explained later.  

Once you have selected your series data, you're ready to view the new chart – simply close the window and 
your new chart will display (charts that are linked to a data pipeline will need to be previewed in Clarity 
before the data will show in the designer).  
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Dashboard Parameters 

Dashboard parameters are very similar to other Clarity parameters, and are used in much the same way. 
Parameter definitions are stored in a CLS file and retrieved at runtime to produce the report. The 
parameter values are stored against a Dashboard view setup. 

Basically, parameters in the Dashboard work like this:  

 
Note: Some errors are suppressed in the dashboard, and it could be irritating to have messages or 
parameter windows popping up each time the dashboard refreshes – so when designing your own 
dashboard reports, rather than giving an error if the correct parameters are not supplied it is smarter 
to use some sensible default values and continue running the report.  

Adding New Parameters 
You add parameters to a dashboard report the same way you do any other type of report. Go to Clarity's 
Tools > Runtime Parameters menu (consult the Clarity documentation for further details on setting up 
parameters).  

Setting Parameter Values 
Once parameters are set up in the dashboard report, the parameter values can be set in the dashboard 
setup screen:  
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Click the Parameter button to open the parameter window:  

  

Notice that parameter defaults are shown if there are not already parameter values assigned to this 
dashboard; otherwise the previously selected parameter values are shown. Select the desired values and 
click Save. Notice how the parameters are added after the report (CLR) name in the Report Settings field, 
using the same format as regular command-line parameter values (see page 79). 

Advanced Chart Properties 

Chart Properties Overview 

This section describes the main tree view nodes from the chart properties window with a brief explanation 
of each. Only a fraction of the available properties are documented here; if you're unsure about a particular 
property, create a new blank report with some random data and have a play with it until you understand it.  

 
Note: The property pages that appear on the right hand side as you click items in the tree layout will 
dynamically re-organise depending on what you've selected. For example, if you select the "Chart" 
node, you'll see tabs for General, Axis, Titles, ... and so on, with all their respective property pages 
underneath each one. If you select "Axis", you'll only see the property pages under Axis, and so on.  
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From here on the notation for locating a property will be as follows:  

Node > Property page > ... > Property  

"Node" may be "SeriesName", which means whatever series name you have chosen (in the case above the 
default is Series1). 

Series 

Under Series you will find a node for each of the series that you have added to the chart. Click on the node 
of the series you want to modify to display the property pages. These property pages are for properties 
that relate to the series itself, how and where the series is displayed, number formats for marks (labels) on 
the series, label formats and the data source.  

Some commonly used properties:  

SeriesName > Format > Size – Sets the size and offset of the bars.  

SeriesName > Stack > Multiple Bar – Specifies how this series should stack when combined with other 
series in a multi-series chart  

SeriesName > General > Formats – specifies the format of numbers when marks are used  

SeriesName > General > H/V Axis – specifies which axis should have the ticks for this series  

(e.g. two series with different measurements are assigned left and right axes)  

SeriesName > Marks > Visible – Show or hide the values or labels that accompany each bar/pie 
segment/etc. of the chart.  

General 

General chart behaviour – here you can set options to allow scrolling or zooming on interactive charts (in 
preview mode or on the Dashboard) and set fonts for each of the text fields that makes up the chart.  

Some commonly used properties:  

General > Zoom > Allow – Sometimes the zooming feature can be confusing if the mouse is accidentally 
moved when trying to drill. Click “None” to turn this feature off.  

General > Scroll > Allow Scroll – Sometimes the scrolling feature can be confusing if the mouse is 
accidentally moved when trying to drill. Click “None” to turn this feature off.  

Axis 

Each axis (there are 6 of them, two for each dimension in a 3D chart) has a set of properties to determine 
scales, min/max values, ticks, labels, position and so on. If you're looking for anything to do with one of the 
axes, it will be here.  

Some commonly used properties:  

Axis > (Axis name) > Scales > Inverted – Set this property to invert the axis and all property points along it.  

Axis > (Axis name) > Scales > Minimum/Maximum/Increment > Automatic – Set these properties to 
change the automatic min/max and increment calculations. This will force the chart to use the values you 
select.  

Axis > (Axis name) > Title > Style/Format – Set the axis label here along with the font and display 
properties.  

Axis > (Axis name) > Labels – Set axis label properties here.  

Axis > (Axis name) > Ticks – Set the various tick options here. You can change the size, colour and minor 
tick divisions.  
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Titles 

Here you can set a title, subtitle, footer and sub-footer text, along with the associated display properties 
(borders, colours, shading, etc).  

Some commonly used properties:  

Titles > (Title type) > Style – change the title text for your chart here.  

Legend 

The legend is optional for all reports, and there are plenty of options  

Some commonly used properties:  

Legend > Style > Visible – Whether or not to show the legend. The chart will resize to fill the unused space 
if the legend is hidden.  

Legend > Style > Text Style – Set the text that appears in the legend here from a number of potential 
options including left/right value and percent.  

Panel 

The panel refers to the chart background. This can be coloured or gradient colour. If the chart is set to 
“Transparent” (a Clarity property of the chart, not a chart property) then the Dashboard will attempt to 
make the chart transparent when it is displayed. This may not always work as expected.  

Paging 

This is intended for printing multi-page charts, but is not tested in the current version of Clarity.  

Walls 

A wall is a plane that makes up one of the sides of the 3D chart. In the default 3D chart, there are 3 walls 
visible: the X axis wall, the Y axis wall, and the back wall. If you add a right axis then another wall will be 
created for that axis. The walls help give 3D charts their depth, but 2D charts also use the back wall.  

3D 

Set the 3-dimensional viewing properties for 3D charts including zoom, rotation, elevation and perspective. 
Remember that in Dashboards, you may be better off going with 2D charts, as they are clearer and easier to 
read values from.  

Data 

Shows a grid of the data elements for all series (static chart only, not when bound to a data pipeline). These 
values can be updated from here or from the individual Series > Data Source tab.  

Export 

You can export charts directly from the chart properties pages, without having to preview them, so long as 
the chart is not bound to a data pipeline. Export formats include Bitmap, metafile, HTML table and Excel 
spreadsheet.  
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Print 

You can also print the charts directly from the properties pages without previewing. This will only print the 
chart and is not related to the other printing or previewing functions of Clarity.  

Gradient Panel 

The gradient panel is a tool used for creating simple gradients (horizontal or vertical) in a rectangle. The 
properties are similar to a regular rectangle shape, but you cannot change the shape type, and there is a 
new property for “Color end”. The properties are listed below.  

  

Border  
This allows you to add a border around the shape on one or more sides. Click the “+” to see more options.  

Center  
This centres the gradient shape in the bounding area that you have selected. Note that this only really has 
an effect if “MaintainAspectRatio” is selected, then the shape will be limited to the largest square that can 
fit in the rectangular area, and this option will centre it in that area.  

Color  
This sets the start colour of the gradient.  

Color End  
This sets the end colour of the gradient  

DirectDraw  
This property is not used.  

MaintainAspectRatio  
This forces the visible shape into a square – the largest square that can fit in the rectangular area you've 
selected.  

Style  
This determines which way the gradient shows, horizontal or vertical. The values are: gsLinearV = Vertical, 
gsLinearH = Horizontal.  
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Transparent  
Sets the transparent property of the gradient panel. This will make non-black colours appear transparent so 
that other objects can be seen underneath. The lighter the colour, the more transparent (white is fully 
transparent).  

Note: Transparency may not work too well with shapes or text that is not either black or white – this 
should only be a problem. In addition, transparency will only work when viewed on screen. Printed 
gradient panels will not be transparent.  

Visible  
Sets whether the panel is visible on the preview or printed report.  

Tee Chart Events 

OnClick Event 
The OnClick event is useful if you just want to perform some action if a click is made anywhere on the chart 
component. This is particularly useful for line charts – you can add OnClickSeries events for a line chart, but 
it can be difficult for someone to move the mouse in the right place to actually click on the line. In this case, 
clicking anywhere on the chart may suffice (not if you want a particular data point though).  

This event is used in the "top" dashboards, e.g. DashTopCustByMargin.CLR, where if you are drilled into an 
item clicking on the line chart of the history will "drill" back up to the original view. It doesn't matter where 
on the line chart you click, the same event is fired.  

Here is the procedure definition for an OnClick event handler:  

 procedure TeeChart1OnClick(ppCustomTeeChart: TppCustomTeeChart); begin  

end;  

Notice that a parameter is passed to the event handler which references the chart that was clicked. At this 
stage there is not much you can do with that parameter, but more functionality may be added in the 
future.  

OnClickSeries event 
The OnClickSeries event is used whenever you want to perform a specific action when someone clicks on a 
data series element. Examples of data series elements are series lines in a line chart, bars in a bar chart, pie 
segments in a pie chart, and so on.  

When an OnClickSeries event is fired, the event handler is passed a reference to the element which was 
clicked on. Here is the procedure definition for the event handler:  

 procedure TeeChart1OnClickSeries(SeriesIndex: Integer; ValueIndex: Integer; Button: 
TMouseButton; X: Integer; Y: Integer); begin 

end;   

Here we are passed some more useful data:  

The SeriesIndex value is the index of the series that was clicked (remember you can have multiple series in 
your chart). The first series is 0, the second is 1, and so on.  

The ValueIndex value is the index of the value in the series that was clicked. While this may not mean much 
if you don't know what data is in your data source, there are some ways that this can be useful. In many of 
the standard dashboards, a description is stored in a list that is later referenced using this value.  
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The Button value is a reference to which mouse button was clicked. It is outside the scope of this 
document. For the purposes of this explanation, all mouse clicks will fire the event (left, middle and right).  

The X and Y values give the coordinates where the click was made. This will likely be of little value.  

OnMouseMove event 
The OnMouseMove event is used to trigger changes in the cursor. The cursor does NOT automatically 

change from a regular mouse pointer: to a link pointer:  

All the bar charts that use OnClickSeries events also use an OnMouseMove event to make the pointer 
change to a link pointer when one of the bars is hovered over. There are not many other uses for this event 
at this time. Here is the code snippet:  

 procedure DPTeeChart1OnMouseMove(X: Integer; Y: Integer);  

var  

ClickedPart:TExoClickedPart;  

begin  

ClickedPart:=DPTeeChart1.CalcClickedPart(X, Y);  

if ClickedPart.Part=cpSeries then  

DPTeeChart1.Cursor := -21  

else  

DPTeeChart1.Cursor := 0;  

end;   

Notice the use of the function DPTeeChart1.CalcClickedPart(X, Y) to return a value which indicates which 
part of the chart was “clicked” (a “mouse move” event is internally handled much like a click event – 
hundreds of little events fire every time you move your mouse). The cursor is then changed to -21 if it is 
part of the Series (i.e. a bar , pie slice, etc.). The value -21 represents the link pointer. The value 0 
represents the regular arrow mouse pointer.  

OnPrint event 
The OnPrint event is much like the OnPrint events of any other report component. It will fire when the 
chart is being generated for viewing in the preview screen or printed to the printer. This event will not fire 
if the chart is printed from the chart's property pages, only if it is printed through the usual way in Clarity.  

Dashboard Programming 

New Concepts 

Custom Programs 
While you are probably familiar with modifying other code in various event handlers, you can actually write 
your own routines that can be called as many times as you like from as many places in your report as you 
like. This encourages code re-use, reduces repetitive coding in the same report, and makes it easier to fix 
bugs or test changes because you only need to change one place.  

New functions or procedures can be created in the Calc tab of Clarity by going into the “Programs” tree 
view item, then right-clicking on the events list pane. You can choose either “New Function” or “New 
Procedure”:  
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A function allows you to return a value after some processing has occurred, while a procedure is just for 
processing and does not return a value. Both functions and procedures can be passed any number of 
parameters in the same way you'd pass parameters to any other Calc procedures. Once you've created the 
new function or procedure, you can begin adding code straight away.  

Have a look at the function below which takes a single data parameter and returns a string saying how 
many days it is until Christmas:  

 function HowLongTillChristmas(var MyDate: Date): Variant;  

var  

Christmas : date;  

dd : integer;  

mm : integer;  

yy : integer;  

numDays : integer;  

begin  

DecodeDate(MyDate, yy, mm, dd);  

Christmas := EncodeDate(yy, 12, 25);  

numDays := Christmas - CurrentDate;  

if numDays > 0 then  

Result := 'Only ' + IntToStr(numDays) + ' days ''til Christmas!'  

else if numDays = 0 then  

Result := 'It''s Christmas!!'  

else  

Result := 'Christmas has passed, wait until next year!';  

end;   

The Result variable is a special variable only available in functions which takes the result which is passed 
back to whatever called it. This function can then be called from anywhere in the report, as in this example: 
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ShowMessage(HowLongTillChristmas(CurrentDate));  

Since we know the call returns a string, we can put this straight into a ShowMessage procedure. See the list 
of custom programs (see page 151) to see how these are used in the standard dashboard reports.  

Setting a data pipeline range (record count) 
All the “top”-style dashboard reports allow you to filter on a number of records, or a range count. This is 
achieved by setting some properties on the data pipeline object before the data is queried or refreshed. It 
will not filter or limit a data set that has already been retrieved (unless you specifically force the data to be 
refreshed, which will re-query the database). In the OnBeforeOpenDataPipelines event (or other suitable 
place), you can put lines like the following: 

 Master.RangeBegin := rbFirstRecord;  

Master.RangeEnd := reCount;  

Master.RangeEndCount := nCount;  

Where Master is the data pipeline name and nCount is a positive integer specifying the maximum number 
of records to be retrieved. rbFirstRecord is a special internal variable telling the database where to start, 
reCount is a similar variable telling it where to finish, and nCount is the actual record count. If you'd like to 
set it back to returning all records, set Master.RangeEndCount := reCount;  

Setting the page size 
In order for the Dashboard reports to be dynamic (i.e. So when you choose “Top 10” it only shows 10, and 
when you select “Top 50” it expands to show all 50), the page size itself needs to change. Without changing 
the page size dynamically, you'd need to have a fixed page that was as long as the longest that your 
Dashboard could possibly be, otherwise your data would flow onto second and subsequent pages, and 
since you can't change pages in the Dashboard view, the data would be hidden from the user. Since having 
very long pages is not an ideal solution, page resizing is currently used on all the standard Dashboard 
reports.  

In order to set the page size, you need to change a Printer Settings property of the report. In our case, we 
can set the page width and margins at design-time, and all we need to worry about at runtime is the page 
height. Here is an example:  

 Report.PrinterSetup.PaperHeight := nNewPageHeight;  

Unfortunately, dynamic page height often depends on the number of records you have retrieved from the 
database, so the page resizing needs to occur after the detail bands have all been calculated. Unfortunately 
again, resizing the page alters the entire flow of all the sections of the report (potentially) so it needs to 
happen before the final report has started generating. So we need to do this in a four-step process:  

1. Expand the report to be arbitrarily high in the Page Setup (say, 4000 pixels).  

2. Allow the report to run once through and we should get all the Detail records on one page (if they 
don't all fit, tough). If we don't try and get them all on one page, often the records on the second 
and subsequent pages won't be calculated at all (since they are generated only when you move to 
page 2).  

3. Count the number of detail lines and calculate how long the page should be – don't forget to take 
into account the top & bottom margins, all visible sections, all group headers and footers (one of 
each for each group), and all detail lines (one for each record in the Master pipeline). This is 
complicated by the fact that there's no way to calculate the actual printed height of sections that 
have dynamically adjusted height – you can only get the value of the height that was set in the 
design canvas – Tricky! Try to avoid dynamic height sections (and stretching memo fields, etc.) for 
this reason.  
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4. Resize the page with the newly calculated height and refresh the report – see below. This will both 
redraw the report and re-query the database. There's no way to just redraw the report at this 
stage, but this feature may be added in the future.  

Here's the final piece of code that is used in many Dashboard reports (not including all the tricky 
calculations are done to determine the page height): 

 Report.PrinterSetup.PaperHeight := nPageHeight  

+ Report.PrinterSetup.MarginTop  

+ Report.PrinterSetup.MarginBottom + 50;  

You can find this in the “ResizePage” Custom Program of each report. 

Refreshing the report 
In order to refresh the data pipelines by re-querying the database, redraw the resized page and refresh any 
components that have not updated themselves when changes are made at runtime, you need to call the 
following routine:  

 RefreshPage(Report);  

Note: This function should not be used carelessly – it does a complete refresh of the entire report 
including all data pipeline querying, as if you had closed the report and reopened it – in other words 
it is NOT fast. Too many of these in your report will slow down significantly.   

Also be aware that even if you only have one instance of it, you should check to ensure it is not called 
multiple times, particularly if you have your report set to “Two-Pass”. To verify this, put a ShowMessage 
command immediately before it. If the message appears more than once then you need to check why. Try 
moving it elsewhere or set the report to “One-Pass”.  

Having said that, there may be times when you need to call it twice in short succession, but this should be 
avoided if at all possible.  

The TStringList (1-dimensional String Array) 
This is the only type of “array”, as it is known to programmers, that is available for use in the Clarity Calc 
tab. It is a data type you can use anywhere in your code to hold a list of string values that can be referenced 
by index in the list. You add a new item to the list as follows:  

 var MyStringList : TStringList;  

begin  

MyStringList.Add('This is the first item in my list');  

MyStringList.Add('This is the second item in my list');  

...  

You can then easily access any item in the list like this: 

 ...  

ShowMessage(MyStringList[0]); { This displays the first item }  

ShowMessage(MyStringList[1]); { This displays the second item }  

end; 
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Notice the square brackets after MyStringList – you must use square brackets for this. If the entry you 
request from the string list does not exist you will get an error (e.g. if you were to have another line 
referencing MyStringList[2] you would get an error). TStringLists use what's called a “zero-based” index, 
because the first item is always zero.  

For example in the Dashboard reports, open DashTopCustbyMargin.CLR where four TStringLists are used. 
These are global variables: they are defined in the Definitions section of the Calc tree view, empty records 
are created in the list (before they are needed) in the GlobalOnCreate event handler, then they are 
populated in the DetailAfterGenerate event handler as the data is retrieved. A description of each is below:  

• gslAccNos – this is used to store the account numbers (ACCNO field) of each account that is shown 
in the list, so that when one of the bars on the chart is clicked the ValueIndex of the clicked bar (see 
page 145) corresponds to an entry in the list that holds the clicked account's AccNo which is then 
applied to the filter for the drill-down data pipeline, then the pipeline can be refreshed to show the 
data for that account.  

• gslHeadAccNos – this is used for the special case where an account in the list has a HEADACCNO 
field set – I.e. it is a sub-account of another account. It will not be discussed here.  

• gslAccNames – this is used to store the account name so that it can be used to set the chart 
heading of the “drill-down” chart showing the customer sales history. It is easier to store it with the 
other values than pick it up when the database is re-queried.  

• gslAlphaCode – similar to the account name, this is used to store the alpha code of the account for 
use in the history chart heading.  

Custom Colours 
You can define any colour you like in Clarity. You may have used one of the colour palette dialogue boxes to 
come up with new colours, but you can also specify them in code if you know the Red/Green/Blue (RGB) 
values of the colour – red, green and blue being the primary colours of the spectrum of light. The RGB 
function takes three integer parameters, one for each colour, from 0-255 indicating the intensity of that 
colour. So RGB(0,0,0) is black (no light of any colour) and RGB(255,255,255) is white (full intensity of red, 
green and blue).  

You can use a custom colour in the following way:  

 Label1.Font.Color := RGB(200, 0, 0); { a relatively bright red colour } 

Label2.Font.Color := RGB(100, 200, 100); { a pale green colour }  

Label3.Font.Color := RGB(0, 0, 80); { a deep blue colour }  

Using DrawCommand Tags 
Sometimes, you need to be able to store something against a detail line that is being generated, as it is 
being generated for future reference (perhaps string lists are not sufficient for some reason). One way of 
doing this is by storing a value (integer only) against the “Tag” property of a DrawCommand object.  

Some background: When you create an event handler for the “Click” event of a label in the Detail band (for 
example), it's actually the OnDrawCommandClick event you're using – you might have noticed. What this 
does is it actually creates a special DrawCommand object for each instance of the label that is created, and 
this DrawCommand object is passed to both the OnDrawCommandClick event handler and the 
OnDrawCommandCreate event handler.  

Don't worry too much about what this DrawCommand object is or what it does, but we're interested in the 
fact that we can tell what the user clicked on if we store a reference number in the Tag property of the 
DrawCommand when it was created.  
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For example, let's say we have a report that lists Debtors by their account name (among other things). If the 
DBText field is called AccName, we can store an ACCNO value in a DrawCommand tag for each Detail record 
by adding an OnDrawCommandCreate event handler like this: 

 procedure AccNameOnDrawCommandCreate(aDrawCommand: TObject);  

var  

lDrawCommand: TppDrawCommand;  

begin  

lDrawCommand := TppDrawCommand(aDrawCommand);  

lDrawCommand.Tag := Master['ACCNO'];  

end;  

Now by also adding some basic code to the Click event handler, we can open the MYOB EXO Business 
account screen for the clicked Debtor:  

 procedure AccNameOnDrawCommandClick(aDrawCommand: TObject);  

var  

lDrawCommand: TppDrawCommand;  

begin  

lDrawCommand := TppDrawCommand(aDrawCommand);  

ShowDebtor(lDrawCommand.Tag);  

end;   

That's all that's required! It is quite confusing, though, particularly having to convert the aDrawCommand 
TObject into a TppDrawCommand object before using it. Just use those code snippets above and don't 
worry too much about the details if you don't understand.  

This same effect cannot be achieved by simply having an ACCNO field in the detail band and using this to 
open the debtors screen. If you try it you will find that it always selects the last debtor in the list. That is 
because once the detail lines are generated, you cannot reference their values again. You can, however 
reference the DrawCommand Objects because they are passed in as parameters to the Click event, as 
shown above.  

Custom Program Examples 

Here are some of the Custom Programs that were created and are re-used through several (or all) standard 
Dashboard reports as of this writing. They may also be useful for your Dashboard reports. 

DrillDown(ValueIndex) 
This procedure was designed to be called directly from the chart OnClickSeries event handler with the index 
of the clicked value. While different reports work slightly differently, the procedure basically re-filters a 
drill-down pipeline, sets some variables, then shows and hides various parts of the report to actually make 
the drilldown happen. Finally the page is resized, as the drilldown view is rarely the same height as the 
original view.  

ResizePage 
This procedure does all the calculations to work out how high a report page should be, sets the height, then 
refreshes the report. This procedure differs somewhat between a few of the reports, because each report 
has a different page layout that requires a different height calculation.  
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SetDateFilterParm(Period, Refresh) 
This procedure (designed for “top”-style reports) takes two parameters: a string of the period (Week, 
Month, Year or All) and a parameter stating whether the report should refresh after setting the filter 
parameters or not.  

This calculates the “From” date to apply as the TRANSDATE field filter based on the selected period and the 
current date. The clicked “tab” is marked as selected, then the AutoSearch criteria is then set and the 
report is optionally refreshed. The optional refresh flag is in place to avoid unnecessary report refreshes 
which slow down the report significantly. 

SetRecordCount(Count, Refresh) 
Similar to above, but it sets the record count, edits the radio buttons and optionally refreshes the report.  

SwitchBack 
This procedure performs the reverse of the Drilldown procedure, hiding what was shown and showing what 
was hidden. Re-filtering is not necessary. It also takes into account whether the original view was on the 
chart of table view and shows the appropriate components. 

SetProgressBar(Region, Percent, Text) 
This procedure sets the bar in the progress indicator to the desired length. You pass in a percentage (0-100) 
and it will calculate the length for you. If you pass an empty text string it will simply show the percentage as 
a string. Here's the progress bar in action in a sales analysis Dashboard report:  

 

Inserting or Clearing Data 

You can manually insert data by simply getting the series you are looking for with “SeriesByTitle”, then call 
the series' Add procedure with the label and value:  

 var Series:TChartseries;  

begin Series := DPTeeChart4.SeriesByTitle('Series1'); Series.Add('First item', 125.4); 
Series.Add('Second item', 131.8);  

end; 

To remove all items, simply call the Clear procedure: 

Series.Clear;  

Have a look at some of the “Top”-style reports for more details. Check the subreport, looking at the 
DetailAfterGenerate event and the ReportOnStartFirstPass event.  

Showing or Hiding a Series 

You can set the series Visible property to show or hide it as required: 

Series.Visible := false; { hides this series }  

Using Parameter Fields in Dashboard Reports 

Dashboard parameters are used in the report in exactly the same way as any other Clarity parameters. 
Have a look at the following code from the overdue accounts dashboard views and note the bold plParams 
references:  
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 procedure ReportBeforeOpenDataPipelines;  

var  

ppTemp: TppAutoSearchField; 

yy,mm,dd: integer;  

MyDate: Date;  

duewithin: string; branch: string;  

begin  

branch := plParams['BranchDisplayValue1'];  

if branch = '' then branch := 'ALL BRANCHES';  

BranchParam.Text := branch; 

 

duewithin := plParams['DueWithinDaysValue'];  

if duewithin = '' then  

begin  

duewithin := '0'; { defaults to show only overdue invoices if no value specified }  

SubHdParams.Text := 'Due today or overdue'; 

end else begin  

SubHdParams.Text := 'Due within ' + duewithin + ' days / Overdue';  

end;  

MyDate := CurrentDate + Strtoint(duewithin);  

DecodeDate(MyDate, yy,mm,dd); 

  

ppTemp := Report.CreateAutoSearchCriteria('CR_TRANS', 'DUEDATE',  

soLessThanOrEqualTo, inttostr(dd)+'/'+inttostr(mm)+'/'+inttostr(yy),  

True);  

end;  

Programming Exercises 

Create a new report with a simple data source that returns Debtor account names and AGEDBAL0 fields, in 
descending order by AGEDBAL0. Apply a range filter on the report so that it only lists the first 5 debtors.  

Exercise 1 
1. Create three labels at the top of your report from (1), “5”, “10”, “20”.  

2. Add a click event handler for each of these  

3. In the event handlers, add a call to a new procedure called MySetRange, and pass in the integer 
values of 5, 10 and 20 respectively.  

4. Create the MySetRange procedure which updates the range value and refreshes the report.  

5. Save your report then test it by previewing to make sure that the range is indeed updated as you 
click on the labels.  
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Exercise 2 
1. Create a new Global TStringList variable  

2. Add some code to the DetailAfterGenerate event handler to add the stockcode field to the string 
list  

3. Change the click event on the chart series to look up the stock code in the list instead, and open the 
MYOB EXO Business Stock screen.  

4. Try copying the progress bar from one of the Sales Analysis Dashboard reports onto your report 
with the two new procedures. Try to get it to work properly.  
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Glossary 

A 
Advanced Component Palette: A toolbar that contains advanced components. 

Align: The act of setting components' positions so they line up with one another. 

Align or Space Toolbar: A toolbar that allows you to align or space components so that they have a 
uniform appearance. Select View> Toolbars> Align or Space to launch this toolbar. 

AutoSize: A speed menu option available for text components. When AutoSize is set to true, the 
component adjusts its width so that all of the text is displayed. 

B 
Band: A section of canvas that describes how part of the report will look. A band is labelled in the 

section divider immediately below it; thus, the first band is called the 'header', the second is called 
the 'detail', and the third is called the 'footer'. 

Barcode: A component in the Standard component palette that renders barcodes. Use the Edit toolbar 
to set the data to be encoded. Right-click and access Configure to select bar code types. 

Boolean value: Which only have two possible values, True or False (off/on, 0/1, they are all just 
representations of the same thing). 

Bounding box: (1) A method of component selection by which you right-click your mouse and drag it so 
it encompasses the components to be selected. (2) The box that appears around the components 
to be selected as you drag your mouse. 

Bring to Front: A speed menu option that allows you to move an object in front of other objects. Use 
this option to control the appearance of over-lapping objects. 

C 
Calcs page: A page in the Query Wizard that allows you to make a calculation based on the data in the 

database. 

Calcs tab: An advanced tab in the Query Designer used solely by MYOB EXO Business developers from 
which you can create a calculation based on the data in the database. 

Calculation: An option in the Query Wizard /Query Designer that allows you to derive new data from 
existing database fields. 

Canvas: The area in the design workspace that contains the reports layouts. The canvas is divided into 
rectangular areas called bands. 

Component: An element used to control how the report looks. Each component has a unique purpose. 
In order to place a component in the design workspace, click the icon on the component palette, 
and then click on the white space of the band in which you want the component to appear. When a 
component is selected, an edit or drop-down list may appear in the upper left hand corner of the 
design workspace. This area provides different options depending upon the selected component. 

Configure: A speed menu option for the Crosstab component. It allows you to access the Crosstab 
Designer. 

Crosstab: A component that presents summarized data in a grid format. Crosstabs are designed by 
right-clicking over the component and accessing the Configure option. 

Crosstab Designer: The dialog displayed when the Configure option on the speed menu for the 
Crosstab component is selected. A Crosstab layout is created via this designer. 
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Crosstab Wizard: A tool in the design workspace that generates a report based upon the choices you 
make in the wizard. Access this tool by selecting File> New, then clicking the Crosstab Wizard icon. 

D 
Data Component Palette: The palette from which you create data-aware components. Click on the icon 

and click on the canvas to create a data-aware component. 

Data module: A behind-the-scenes container for dataviews. When you want to copy data from one 
report to another, export the data module from the first report and import the data module into 
the second. 

Data pipeline: A special kind of component that manages the connection to the database and supplies 
data to a report. It also controls which rows of data are used to generate the report. It represents 
an MYOB EXO Business database table or SQL query and provides data in the form of fields and 
records. A Pipeline is opened automatically when you log into MYOB EXO Business. 

Data tab: The tab that you access to select data. 

Data traversal: The act of moving through the rows of a database table or data selection. 

Data Tree: A toolbar used in the design workspace to access the data selected in the data workspace. 
Select View> Toolbars> Data Tree to launch this toolbar. 

Data-aware components: Components to which you can assign data fields. In the Report Designer, 
these components are prefixed by DB, meaning 'database'. 

Database table: A structure that facilitates the storage and retrieval of organized data. 

Dataview: The visual representation of a query displayed on the data tab. It contains the data selected 
in the Query Wizard or Query Designer. Dataviews allow you to make changes to a query via the 
Query Designer, which can be accessed by clicking the icons in the dataview tool-bar. 

DBComponents: Data-aware components that can retrieve data from a query. The DB prefix stands for 
database. Use the edit toolbar to choose data for a DBComponent. 

Delphi programming language: A programming language that derived from Pascal, with an object-
oriented programming extension. 

Design tab: The tab in which you create your report layout. 

Detail Band: A band that prints once for every row of data. 

Display Format: A speed menu option available for textual components. This option allows you to 
display a value in a certain format (decimals with a dollar sign, for example). Right-click over a 
textual component to access the Display Format. 

Dock: The act of dragging a toolbar to one side of the workspace and dropping it such that it 'sticks' to 
that side. A docked toolbar moves when you move or resize the Report Designer. 

DR_ACCGROUPS: Stores the names of the account groups. 

DR_ADDRESSES: Is for multiple delivery addresses, not normally needed in reporting. 

DR_ALLOCATIONS: Stores information about allocating cash receipts and is used for multi-currency. 

DR_CONT_HIST: Stores notes about the contacts. 

DR_CONTACTS: Stores the information about individual contacts, if used. 

DR_LINE_DISCOUNTS: Store information about the more complicated pricing structures and discounts. 

DR_PRICES: Store information about the more complicated pricing structures and discounts. 

Draw Toolbar: A toolbar used to fill a component with colour or to colour the border around a 
component. 
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E 
Edit: A speed menu option for a Rich Text component that opens an application that allows you to open 

a file and format text. 

Edit Toolbar: A toolbar that allows you to set the most important property of a component. This 
toolbar changes to select database fields for data-aware components, adjust lines for the line 
component, select shapes for the shape component, and type text for the label component. 

Events: Events are granular steps in the generation of your report, and each time an event happens, an 
“event handler” is run if it exists.  Event handlers are pieces of code that tell Clarity what to do 
when the event happens. 

Expression: It is used when creating a calculation. It allows you to create other fields based on the data 
from existing fields. 

F 
Floating Point number: These are like integers, but they do allow numbers after the decimal point, e.g. 

an amount field.  You may see floats being called “Extended” in Clarity. 

Floating window: A toolbar detached from the edge of the Report Designer and released so that it 
'floats' in front of the Report Designer. 

Footer Band: A band that prints (usually the page number, date, time) at the bottom of each page of 
the report. 

Format Toolbar: This toolbar gives you the ability to modify text-based components in a number of 
ways. You can change the font style and font size. You can bold, italicise, or underline the text. You 
can justify a word or sentence to the left of the margin, or you can centre or right-justify text. You 
can also change the colour of the text. 

G 
GL_ACCGROUPS: Holds the group names. 

GL_CONTROL: Stores various control file settings 

GL_SUBACCS: Stores master-file information about the sub accounts, if used 

GLACCS: Holds the account master file information, with the nature of the account (balance sheet, 
dr/cr, taxstatus). 

GLTRANS: Stores the transactions 

Group: (1) A section of a report that contains a group header, detail, and group footer band. Groups are 
assigned to a database field. Select Report> Groups to access the groups dialog. (2) A behind-the-
scenes component that allows a report to be organized into separate sections, based on the value 
of a field. 

Group Footer Band: A band that contains the footer for a group. The components in a group footer 
band appear at the end of a group. 

Group Header Band: A band that contains the header for a group. The components in a group header 
band appear at the beginning of a group. 

Guides: The lines on the horizontal and vertical ruler that move as you move the cursor over the 
canvas. 

H 
Header Band: A band that prints at the top of each page of the report. 
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Highlight: To select text for editing. You highlight text by holding down the mouse button and dragging 
the cursor over text or by holding down the Shift key and pressing an arrow key. 

I 
Image: A component on the Standard component palette that displays graphics (such as bitmaps, GIFs, 

and JPEGs). 

Integer: Whole numbers with no decimal portion, e.g. an account number. 

K 
Keep group together: An option in the group’s dialog that sets the group so that the bands of the group 

will print on the same page 

L 
Label: A component useful for titles and headings. Use the Edit toolbar to set the text for a label. 

Label Template Wizard: A tool that allows you to create mailing label reports by selecting printer 
information and choosing a label type. 

Line: A component in the Standard component palette that displays a line. Use the Edit toolbar to set 
the line orientation. 

Lines: A speed menu option for a memo that allows you to access the Memo Editor, from which you 
can open text only files. 

M 
MailMerge: An option that appears when you right-click over a Rich Text component. It allows you to 

import field values into the Rich Text component. 

MaintainAspectRatio: A speed menu option available for images. It scales an image so that the height 
and width are adjusted based on the original image size. 

Memo: A special kind of component that allows you to load text into it. Right-click over the memo and 
select Lines in order to load text. 

Memo Editor: A dialog accessed via the memo component (right-click over the component and select 
Lines) that allows you to load and save text files. 

N 
Nudge Toolbar: This toolbar allows you to move a component or a group of selected components one 

pixel at a time. See page 100 for a complete description of this toolbar. 

O 
Object: In the simplest sense, Objects are just abstract entities that represent “things”.  Your report is 

an object.  A label on your report is an object.  A picture on your report is an object.  Lines, regions 
and anything else that makes up your report is also an object. 

Orphan: (1) A component(s) that prints on a different page than the components within the same band 
or region. For example, if a DBText that's supposed to follow a DBMemo prints at the top of the 
next page rather than with the DBMemo, it is orphaned. (2) A group footer band that prints at the 
top of a page with no preceding detail bands. 

Overflow: Occurs when a stretchable component prints on additional pages. 
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P 
Pagination: A speed menu option for a Crosstab component that allows you to choose Across then 

Down or Down then Across printing for the Crosstab report. 

ParentHeight: A speed menu option that allows you to set the size of an object so that it matches the 
height of a band. Right-click over a component to select ParentHeight. 

ParentWidth: A speed menu option that allows you to set the size of an object so that it matches the 
width of a band. Right-click over a component to select ParentWidth. 

PipeLine: A connection to the MYOB EXO Business database opened automatically whenever you log 
into MYOB EXO Business. 

Position dialog: A speed menu option that allows you to change the size and position of an object. 
Right-click over a component to access the Position... dialog. 

Preview: A tab workspace where you can preview the generated report to see how it will look when 
printed. 

Properties: Settings for components such as font style, size, and colour. 

PURCHORD_HDR: Is the header table with information on delivery address and other reference items. 

PURCHORD_LINES: Contains the information about individual products ordered, quantity, price, 
supplied, invoiced, and any text entries. 

Q 
Query: A request for data using a language specific to databases called SQL. The Query Designer and 

Query Wizards create SQL queries as we choose the data we want for a report. 

Query Designer: A tool that allows you to make changes in the data selection. 

Query Wizard: A tool that allows you to select data for a report. 

R 
Region: A special kind of component that can contain other components. 

Report Tree: A toolbar that displays all of the components in a report. It is particularly helpful in 
organizing components within bands. 

Report Wizard: A tool that allows you to create a report by answering a few simple questions. 

ReprintOnOverFlow: A speed menu option that sets a component so that it will reprint. For example, a 
memo has an accompanying label. If the label is set to ReprintOnOverFlow, it will reprint on each 
page of the memo's text. Right-click over a component to select ReprintOnOverFlow. 

Rich Text: A component that allows you to print formatted text. 

Rich Text Editor: A dialog box accessible via the Rich Text component that allows you to replace text 
with database fields. 

Rulers: The design workspace has two rulers: the horizontal ruler and the vertical ruler. As you move a 
component in the workspace, you'll see a guide that tells you the location of the component on the 
rulers. 

S 
SALESORD_HDR: Is the header table with information on delivery address, customer order number, 

and other reference items. 
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SALESORD_LINES: Contains the information about individual products ordered, quantity, price, 
supplied, invoiced, and any text entries. 

Select: To click on an object. (See 'highlight' as a contrasting term). 

Selection: A group of selected components. 

Selection handles: When multiple components are selected, little grey boxes appear around the 
components. These selection handles indicate the objects that are selected. 

Selection tool: A tool used to select one or more components within the layout. It can also be used to 
clear any selection (by clicking in the white space of a band). 

Send to Back: A speed menu option frequently used with shapes that allows components to be moved 
to the background. If you want to use a shape as a background, use the Send to Back function. 

Shift-click: A method of component selection where you hold down the Shift key and then click on 
components. You can also remove a component from a selection using this method. 

ShiftRelativeTo: A speed menu option that allows you to associate components so that they print one 
after the other. This option is especially useful when you want one component (a memo, for 
example) to appear below another. 

ShiftWithParent: A speed menu option that allows a static component to print after a stretchable 
component. Right-click over a component to select ShiftWithParent. 

Size Toolbar: A toolbar that allows you to set all of the components in a selection to the same width or 
height. 

Sizing: The act of altering the size of a component with the sizing handles or the Position menu. 

Sizing handles: The little black boxes that appear when an object is selected. If you drag your cursor 
over one of the sizing handles, the cursor will change to a double-sided arrow. You can then resize 
the component by holding down the mouse. 

Speed menu: The menu that appears when you right-click over a component. The menu options vary 
depending upon the component. 

SQL Structured Query Language: The language that MYOB EXO Business uses to retrieve data from a 
database in an ordered form so that it can be used to create reports. 

Standard Component Palette: A toolbar that includes the most frequently used components for 
building reports. 

Standard Toolbar: A toolbar that contains standard functions, such as saving, opening, and printing 
reports. 

Start new page: An option in the group’s dialog that allows you to force a group onto a new page each 
time the group field changes value. 

Static components: Components that print just as they appear in the layout. 

Status bar: The bar at the bottom of the design tab that tracks the movement of selected components. 
It is useful for component placement and alignment in that it allows you to position components 
based on an exact measurement. It also displays the name of the selected component. 

STOCK_GROUPS: Stores the names of the stock groups 

STOCK_ITEMS: Stores the details of the stock items, price, availability, supplier details 

STOCK_LOCATIONS: Stores details of the different warehouses, if required. 

STOCK_SERIALNOS: Store serial number information if required. 

STOCK_TRANS: Stores transactions, with quantities, costs, and references 

STOCKTAKE_CTRL: Are used for stocktaking and are not normally referred to in reporting. 
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STOCKTAKE_TOTALS: Are used for stocktaking and are not normally referred to in reporting. 

Stretch: A speed menu option that applies only to stretchable components. When set to true, the 
component will change size depending upon the amount of text it contains. Right-click over a 
component to select Stretch. 

Stretchable components: Components that change size according to the amount of text they contain. A 
DBMemo is a stretchable component. Right-click over a component to set Stretch to true. 

StretchWithParent: A speed menu option that allows the selected component to change height 
according to the change in height of the band in which it resides. Right-click over a component to 
select StretchWithParent. 

Strings: These are just text.  Even if you have a string with some numbers in it, you can't do any maths 
on the numbers without forcing the computer to interpret it as such. Look at some of the 
conversion functions to convert string values if you need to. 

Style: A speed menu option for the Crosstab component that allows you to choose between Repeated 
Captions or Standard printing. 

Subreport: A component that allows you to create a report within a report in order to show more levels 
of detail or to print several reports as one. 

Summary Band: A band that prints once at the end of a report. The band is typically used to summarize 
data. Select Report> Summary to create this band. An invoice total would be in the summary band. 

SuppressRepeatedValues: A speed menu option that prevents repeated values from printing. 

System Variable: A component that allows you to display the page number, time, date, and other 
useful information. 

T 
Tabular: A setting in the Data Tree layout tab that configures the drag and drop behaviour to create 

labels across the top of the page and data flowing down the page. The opposite of vertical. 

Title Band: A band that prints once at the beginning of the report. Select Report> Title to create this 
band. 

Title bar: The area at the top of a window that contains the window title and can be used to drag the 
window to a new position. 

Toolbars: Tools that allow you to modify a report layout. Select View> Toolbars to see a list of all 
toolbars. 

V 
Vertical: A setting in the Data Tree layout tab that configures the drag and drop behaviour to create 

labels down the page and data across the page. The opposite of tabular. 

Visible: A speed menu option that determines the visibility of an object. Right-click over a component 
to select Visible. If the Visible option is set to false, the component will not appear in the report. 

W 
Workbench: The area on the design tab that surrounds the canvas and contains tools used to modify 

the report layout. 
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